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Stresses
Chapter 1

Stresses are quantities used to describe the intensity of force inside a body (either solid or fluid).  Its unit is force per 
unit area (i.e., N/m2 in SI).  It is a position-dependent quantity.
� Imagine that your two arms are pulled by your friends with two forces of the same magnitude, but opposite 
directions.  What are the stresses in your arms?  Assuming the magnitude of the forces is 100 N and the cross-sectional 
area of your arms is 100 cm2, then you may answer, "the stresses are 1 N/cm2 everywhere in my arms."  This case is 
simple; the answer is good enough.  For a one-dimensional case like this, the stress σ  may be easily defined as 

 
σ =

P

A

 where P is the applied force and A is the cross sectional area.
� In 3D cases, things are much more complicated.  Now, imagine that you are buried in the soil by your friends, and 
your head is 100 meters deep below the ground surface.  How do you describe the force intensity (i.e., stress) on your 
head?
� If the soil is replaced by still water, then the answer would be much simpler.  The magnitude of the pressure (stress) 
on the top of your head would be the same as the pressure on your cheeks, and the direction of the pressure would 
always be perpendicular to the surface on which the pressure applies.  You've learned these in your high school.  And 
you've learned that the magnitude of the pressure is  σ = ρgh , where ρ is the mass density of the water (1000 kg/m3 ), g is 
the gravitational acceleration (9.81 m/s2 ), and h is the depth (100 meters in this case).  In general, to describe the force 
intensity at a certain position in still water, we place an infinitesimally small body at that position, and measure the force 
per unit surface area on that body.
� In the soil (which is a solid material rather than water), the behavior is quite different.  First, the magnitude of the 
pressure on the top of your head may not be the same as that on your cheeks.  Second, the direction of pressure is not 
necessarily perpendicular to the surface on which the pressure applies.  However, the above definition of stresses for 
water still holds.  Let me restate as follows:

The stress at a certain position in a solid material is defined as the force per unit surface area on an 
infinitesimally small body placed at that position.

Note that the infinitesimally small body could be any shapes.  However, if we know the stresses on a certain shape of a 
small body, we can infer the stresses on other shapes.  We usually take a small cube to describe the stresses.
� This chapter will guide you to learn the concepts of stresses.
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1.1-1  Introduction

Stress Components
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Section 1.1

[1] Consider a cantilever beam made of an alloy steel and with dimensions of 10 mm x 20 mm x 100 mm [2], which is 
fixed at one end [3] and subjected to a force on the other end [4].  The force is in positive X-direction and has a 
magnitude of 10,000 N.  Note that we've used a reference coordinate system as shown in [5].
� In this simple case, the stress is uniform over the body; i.e., every point in the beam has the same stress.  How do 
we describe this stress?  Can we simply say, the stress is 50 MPa, which is calculated by

10,000 N
10 mm ×  20 mm

= 50 MPa?

 
For a simple case like this, that may be adequate.  In order to apply to more general cases, we need to say something 
more, specifically, what is the direction of the stress?  What is the surface on which the stress acts?

[4] A force of 10,000 N 
is applied at this end.  
The force distributes 

uniformly over the end 
face.  

[2] The beam is made of an alloy 
steel and is 100 mm long with a 

cross section of 10 mm x 20 mm.

[3] The beam is 
fixed at this end.

[5] To describe the force and 
stresses, we use a reference 

coordinate system XYZ.

6� Chapter 1  Stresses
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[10] X-face.

� Section 1.1  Stress Components� 7

[11] Y-face.

[12] Z-face.

[13] Negative-X-face 
(opposite of the X-face).

[15] The 
  
�
p

X
 (force per 

unit area on X-face) can 
be decomposed into  σ XX

, 

 τ XY
, and  τ XZ

. 

Definition of Stress
[6] The stress at a certain point can be defined as the 
force per unit area acting on the boundary surfaces of an 
infinitesimally small body centered at that point [7].  The 
stress values may be different at different faces and 
the small body can be any shape.  However, for the 
purpose of describing the stress, we usually use an 
infinitesimally small cube [8] of which each edge is 
parallel to a coordinate axis.  If we can find the 
stresses on a small cube, we then can calculate the 
stresses on any other shapes of small bodies [18].

[8] We usually use a small 
cube for the purpose of 

describing the stress.

[7] The stress at a 
certain point can 
be defined as the 

force per unit area 
on the boundary 

surfaces of an 
infinitesimally 
small body 

centered at that 
point.

 Y

 Z
 X

 Y

 Z
 X

[16] The   
�
p

Y
 (force 

per unit area on Y-
face) can be 

decomposed into 

 σYY
,  τYX

, and  τYZ
. 

[17] The 
  
�
p

Z
 (force 

per unit area on Z-
face) can be 

decomposed into 

 σ ZZ
, 
 τ ZX

, and 
 τ ZY

. 

X-Face, Y-Face, and Z-Face
[9] Each of the six faces of the cube can be assigned 
an identifier, namely X-face, Y-face, Z-face, negative-X-
face, negative-Y-face, and negative-Z-face, respectively 
[10-13].  Note that X-face has X-axis as its outer 
normal vector, and so on.

Stress Components
[14] Let   

�
p

X  be the force per unit area acting on the X-
face.  In general,   

�
p

X
 may not be normal or parallel to 

the X-face.  We may decompose 
  
�
p

X
 into X-, Y-, and Z-

component, and denote 
 σ XX

, 
 τ XY

, and 
 τ XZ

, respectively 
[15].  The first subscript (X) is used to indicate the 
face on which the stress components act, while the 
second subscript (X, Y, or Z) is used to indicate the 
direction of the stress components.  Note that  σ XX

 
is normal to the face, while  τ XY

, and  τ XZ
 are parallel to 

the face.  Therefore,  σ XX  is called a normal stress, 
while  τ XY , and  τ XZ  are called shear stresses.  In 
Mechanics of Materials, we usually use the symbol σ  
for a normal stress and τ  for a shear stress.
� Similarly, let   

�
p

Y
 be the force per unit area acting 

on the Y-face and we may decompose   
�
p

Y into a 
normal component ( σYY) and two shear components 
( τYX

 and  τYZ
) [16].  Also, let   

�
p

Z
 be the force per unit 

area acting on the Z-face and we may decompose   
�
p

Z
 

into a normal component ( σ ZZ
) and two shear 

components ( τ ZX  and  τ ZY) [17].  Organized in a matrix 
form, these stress components may be written as

�

 

σ{ } =
σ

XX
τ

XY
τ

XZ

τ
YX

σ
YY

τ
YZ

τ
ZX

τ
ZY

σ
ZZ

�

�

�
�
�

�

�

�
�
�
� (1)



 Y

 Z
 X

 σ XX

 σ ZZ

 σYY

 τ XY

 τ XZ

 τ ZY

 τ ZX

 τYX
 τYZ

Stress Components on Other Faces
[18] It can be proven that the stress components on the 
negative-X-face, negative-Y-face, and negative-Z-face can be 
derived from the 9 stress components in Eq. (1).  For example, 
on the negative-X-face, the stress components have exactly 
the same stress values as those on the X-face, but with 
opposite directions [19].  Similarly, the stress components on 
the negative-Y-face have the same stress values as those on 
the Y-face, but with opposite directions [20], and the stress 
components on the negative-Z-face have the same stress 
values as those on the Z-face, but with opposite directions 
[21].
� The proof can be done by taking the cube as a free body 
and applying the force equilibria in X, Y, and Z directions, 
respectively.
� On an arbitrary face (which may not be parallel or 
perpendicular to an axis), the stress components also can be 
calculated from the 9 stress components in Eq. (1).  We'll show 
that this can be done using Mohr's circles (Section 10.1).
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[19] The stress 
components acting on 

the negative-X-face 
have exactly the same 
stress values as those 

on the X-face but 
with opposite 

directions. 

[20] The stress 
components acting on 

the negative-Y-face 
have exactly the same 
stress values as those 
on the Y-face but with 
opposite directions. 

[21] The stress 
components acting on 

the negative-Z-face 
have exactly the same 
stress values as those 
on the Z-face but with 

opposite directions. 

Symmetry of Shear Stresses
[22] It also can be proven that the shear stresses are 
symmetric, i.e.,

�
 τ XY

= τ
YX

,   
 τYZ

= τ
ZY

,   
 τ ZX

= τ
XZ
� (2)

The proof can be done by taking the cube as a free body and 
applying moment equilibria in X, Y, and Z directions, 
respectively.

Stress State
[23] We now conclude that 3 normal stress components and 
3 shear stress components are needed to describe the stress 
state at a certain point, which may be written in a vector 
form

�
 
σ{ } = σ

X
σ

Y
σ

Z
τ

XY
τ

YZ
τ

ZX{ }� (3)

Note that, to be more concise, we use  σ X
 in place of  σ XX

,  σY
 

in place of  σYY
, and  σ Z

 in place of  σ ZZ
.

� The purpose of this section is to familiarize students with 
the 6 stress components in Eq. (3).  The stress field in this 
section is uniform over the entire body.  In the next section, 
we'll explore a nonuniform stress field.
� Another purpose of this section is to familiarize the 
students with the SOLIDWORKS Simulation user 
interface. #
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1.1-2  Launch SOLIDWORKS and Create New Part

About the Textboxes
1.  Within each subsection (e.g., 1.1-2), textboxes are ordered with numbers, each of which is enclosed by a pair of 
square brackets (e.g., [1]).  When you read the contents of a subsection, please follow the order of the textboxes.
2.  The textbox numbers are also used as reference numbers.  Inside a subsection, we simply refer to a textbox by its 
number (e.g., [1]).  From other subsections, we refer to a textbox by its subsection identifier and the textbox number 
(e.g., 1.1-2[1]).
3.  A textbox is either round-cornered (e.g., [1, 3, 5]) or sharp-cornered (e.g., [2, 4]).  A round-cornered textbox 
indicates that mouse or keyboard actions are needed in that step.  A sharp-cornered textbox is used for 
commentary only; i.e., mouse or keyboard actions are not needed in that step.
4.  A symbol # is used to indicate the last textbox of a subsection [5], so that you don't leave out any textboxes.

SOLIDWORKS Terms
In this book, terms used in the SOLIDWORKS are boldfaced (e.g., Part in [4, 5]) to facilitate the readability.

[3] Click New.

[4] Part is selected 
by default.

[5] Click OK to 
create a Part 
document. #

[1] Launch 
SOLIDWORKS.[2] User Interface.
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1.1-3  Set Up Unit System 

[4] Click OK. #

[3] Select None (no 
decimal places) for the 

Length in Basic Unit.

[1] The unit system appears 
here.  Click it and select 

MMGS as the unit system.  
Click it again and select Edit 

Document Units...

[2] The unit system 
also can be 

selected here.
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1.1-4  Create Geometric Model

[2] In the Sketch Toolbar, 
select Center Rectangle.

[1] In the Features Tree (also 
called Part Tree in this book), 

right-click Right plane and 
select Sketch from the 

Context Menu.

[3] Draw a rectangle 
centered at the origin (the 

sizes are arbitrary for now).

[4] In the Sketch Toolbar, 
click Smart Dimension.

[5] Specify dimensions 
(10 mm and 20 mm) 

like this.
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[8] Click OK.

[7] In the Property Box, 
type 100 (mm) for Depth.

[11] The finished 
geometric model. #

[9] In the Head-Up Toolbar, 
click  Zoom to Fit. 

[10] If the view is not Trimetric, 
then, in the Standard Views 

Toolbar, click Trimetric.

[6] In the Features 
Toolbar, click Extruded 

Boss/Base.
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1.1-5  Load SOLIDWORKS Simulation

[2] In SOLIDWORKS 
Add-Ins Toolbar, click to load 

SOLIDWORKS 
Simulation.
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[5] Also click here so that the 
Simulation will be loaded 

automatically each time you start 
up SOLIDWORKS.  Through this 

book, we assume that you've 
checked this box so that the 

Simulation is loaded 
automatically each time you start 

up SOLIDWORKS.

[3] Another way to load the 
Simulation is selecting 

Tools>Add-Ins... from Pull-
Down Menus.

[4] And then select 
SOLIDWORKS 

Simulation to load 
the Simulation.

[6] Click OK. #

[1] If a Simulation tab is already present, 
which means the SOLIDWORKS 

Simulation is already loaded, you may 
jump to 1.1-6 (next page) otherwise 

continue on step [2].



1.1-6  Create a Static Structural Study 

[3] Type Elongation 
for Study Name.
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[4] Click OK.

[2] By default, Static 
(static structural study) is 

the Study Type.

[5] A tab with the study 
name is added and 
becomes active.

[6] A Study Tree 
appears right below the 

Part Tree. #

[1] In the Simulation 
Toolbar, select Study 
Advisor>New Study.
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1.1-7  Set Up Options for SOLIDWORKS Simulation
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[1] From Pull-Down Menus, 
select 

Simulation>Options...

[2] Select Default 
Options tab.

[3] By default, 
Units is selected.

[4] Select SI.

[5] Select mm for 
Length/

Displacement.

[6] Select N/mm^2[MPa] 
for Pressure/Stress.

[7] Select Color 
Chart.

[10] For a Static Study, by default, 
three result plots will be created after a 

successful simulation run.  Let's walk 
through these result plots and adjust 
some settings, which will be used for 

the entire book.

[8] Select General.  The 
number will be displayed 
in either Scientific or 

Floating format.
[9] Select 5 for No. of 

decimal places.
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[20] Click OK.

[11] Click Plot1.

[13] Make sure Nodal Stress is 
selected.  The stress values will be 
reported at Nodes (rather than 

at Elements).

[12] By default, Plot1 reports von Mises 
Stress, which is defined in Eq. 10.2-1(8), 
page 197.  A thorough derivation of von 
Mises Stress is given in 10.2-3 (pages 

200-203).

[14] Click Plot2.

[17] Click Plot3.

[15] By default, Plot2 
reports Resultant 

Displacement, which is 
defined in Eq. 2(2), page 51.

[16] The displacement values 
are always reported at Nodes.

[18] By default, Plot3 
reports Equivalent 
Strain, defined in Eqs. 

10.2-3(16, 17), page 203.

[19] Select Nodal Strain.  
The strain values will be 

reported at Nodes (rather than 
at Elements).

[21] The options set up in 
this page will be permanent 

unless you change them later.  
We'll assume these setups 

through this book.  
Particularly, make sure 
stresses and strains are 

reported at nodes [13, 19]. #
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1.1-8  Apply Material

[1] In the Study Tree, right-click 
Part1 (which is the geometric 
model we've created) and select 

Apply/Edit Material...
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[2] By default, Alloy 
Steel is selected.

[4] Click 
Apply.

[5] Click 
Close.

[3] Elastic Modulus, Poisson's Ratio, 
and Shear Modulus are the three most 
important material properties in Mechanics 

of Materials.  They are discussed in 
Sections 4.1 and 4.2.

[6] Alloy Steel is 
assigned to the model. #



1.1-9  Apply Support

[1] In the Study Tree, right-
click Fixtures and select 

Fixed Geometry...

[2] Click this face.
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[3] The selected 
face appears here.

[6] A fixed support is added 
to the Study Tree under 

Fixtures. #

[4] Click 
OK.[5] This face is 

fixed.
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1.1-10  Apply Load

[2] Click this 
face.

[3] The face 
appears here.
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[6] Click 
OK.

[4] Type 10000 (N).

[1] In the Study Tree, right-
click External Loads and 

select Force...

[5] Check Reverse 
direction.

[7] A force of 10,000 N 
is applied uniformly on 

this face.

[8] A Force is added to the 
Study Tree under 
External Loads. #



1.1-11  Solve the Model
[1] In the Simulation Toolbar, 

click Run This Study.  It takes only 
a few seconds to solve the model.

� Section 1.1  Stress Components� 20

[2] As mentioned earlier (1.1-7[10], page 15), by default, 
results for Von Mises Stress, Resultant 

Displacement, and Equivalent Strain are created.  
Note that Stress1 is highlighted, meaning it is active 

and displayed in the Graphics Area.

[3] By default, Von Mises 
Stress is displayed.  We'll 
change to display  σ X later.

[5] The stress is uniform over the entire body 
except the area near the fixed end, where the 
stresses are complicated and we'll explain this 

phenomenon in 5.2-3[16, 17], page 102.  Let's neglect 
these stress values here for now.

[6] This is the deformed (elongated) 
shape; the deformation is exaggerated.  

We'll turn off the deformed 
shape display in the next page.

[7] We'll turn off the display of 
External Loads and Fixtures 

in the next page. #

[4] Even you follow the 
exactly steps in this book, 

your numerical results 
may deviate from these 

values.  It is acceptable, as 
long as the deviation is 

small enough.
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1.1-12  View the Normal Stress  σ X
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[1] Right-click Stress1 and 
select Edit Definition... 
(or simply double-click it).

[2] Select SX: X Normal 
Stress (i.e.,  σ X

) for 
Component.

[3] Uncheck Deformed 
Shape.  The undeformed 

shape will be displayed. 

[4] Click OK.

[6] Right-click Fixed-1 
and select Hide.

[7] Right-click Force-1 
and select Hide.

[5] Deformed Shape can 
be toggled on/off by clicking 

this button in the 
Simulation Toolbar.
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[9] Remember, let's neglect the 
complicated stresses near the 

fixed end for now.

[10] Except the fixed end, the 
normal stress 

 σ X
 is uniform 

(since the color is uniform). 

[8] Now, the normal 
stress in the X-direction 

(i.e.,  σ X
) is reported.  

The unit is MPa.

[11] By the legend colors, 
the normal stress 

 σ X
 is 

approximately 50 MPa.  
Let's use Probe to 
obtain more precise 

values.

[12] Right-click Stress1 
and select Probe.

[13] Click several locations 
(away from the fixed end) in the 

model to display the  normal 
stress  σ X

.  The normal stress  σ X
 

is indeed uniform and the value 
is 50 MPa.  Click OK in the 

Property Box to dismiss the 
Probe Result. #
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1.1-13  View Other Stress Components

[2] We leave it to you to explore 
other stress components.  Use 
Probe ([12, 13], last page) to 
retrieve precise stress values.

[1] Right-click Stress1 and 
select Edit Definition... 

(or double-click it).

[3] These are six stress 
components (

 σ X
, 
 σY

, 
 σ Z

, 

 τ XY
, 
 τ XZ

, and 
 τYZ

).  Note that 
YZ Plane is the same as 
X-face, and XZ Plane is 

the same as Y-face.

Stress 
Component Stress Value

50 Mpa

0

0

0

0

0

 σ X

 σY

 τ XY

 τ XZ

 τYZ

 σ Z

[4] Write down each stress 
component value.  The results 

should be like this.  In this 
example, all stress components 
are essentially zeros, except 

 σ X
 

(which is 50 MPa).

 Y

 Z
 X

 50 MPa

 50 MPa

[5] The stress state of any point in 
this cantilever beam can be represented 
like this.  In Section 1.2, we'll explore a 
case in which a shear stress component 

is non-zero and the stress states are 
non-uniform. #
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1.1-14  Save the Document and Exit SOLIDWORKS

[1] Click Save and save the document with the name 
Cantilever.  Click Yes for a warning message.  Two files are 
created in your working folder: Cantilever.SLDPRT and 
Cantilever-Elongation.CWR; the former is the main 

project file, while the later stores the result data generated by 
a finite element solver.  Other files, if any, are not relevant; they 

can be deleted.

[2] From the Pull-Down 
Menus, select File>Exit 

to exit SOLIDWORKS. #
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 X

 Y

 Z

1.0 MPa

Nonuniform Stresses
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Section 1.2

1.2-1  Introduction

[1] In the last section, the stress field was uniform over the body and the only non-zero stress component was 
 σ X

.  In 
this section, we'll use the same model as in the last section [2-5], but add a uniformly distributed transversal pressure 
of 1.0 MPa on the upper face of the beam [6].  In this case, non-zero shear stress components exist in the beam and 
the stress field will not be uniform any more.
� This section also demonstrates a way to retrieve results at specific locations in a body, namely the Section 
Clipping method.

[4] A total force of 
10,000 N distributes 

uniformly on this 
end face.  

[2] The beam is made of Alloy 
Steel and of 100 mm long and has 
a cross section of 10 mm x 20 mm.

[3] The beam is 
fixed at this end 

face.

[5] To describe the force and 
stresses, we use a reference 

coordinate system XYZ.

[6] A uniformly distributed pressure 
of 1.0 MPa is applied on the upper 

face of the cantilever beam. #
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1.2-2  Start Up

[1] Launch SOLIDWORKS and open 
the file Cantilever which was saved in 

Section 1.1.  Make sure 
SOLIDWORKS Simulation is 

loaded (1.1-5, page 13).

[2] Right-click Elongation tab 
and select Duplicate from the 

Context Menu.

[3] Type Bending 
and Elongation.[4] Click OK.

[5] A new study is created 
and becomes active.

[6] The new Study Tree 
is simply a copy of that of 
the Elongation study. #
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1.2-3  Add Transversal Load

[2] Right-click External 
Loads and select Pressure...

[1] Click to select the 
upper face of the cantilever 

beam.

[4] Click OK.

[3] Type 1 (MPa) for  
the Pressure Value.

[5] Right-click External 
Loads and select Hide All.

[6] In the Simulation Toolbar, 
click Run This Study.

[7] Remember, let's neglect 
the high stress values near the 

fixed end. #



[5] It is usually more 
informative with an 

animation. 
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1.2-4  Animate the Deformation

[1] Double-click 
Stress1 to edit the 

definition.

[2] Click to turn on 
Deformed Shape.

[4] Right-click 
Stress1 and select 

Animate...

[9] Click OK.

[7] You may adjust 
these animation 

parameters for your 
needs.

[8] You may save the 
animation as an AVI file.

[10] Deformed Shape can also 
be turned on/off by clicking this 

button in Simulation Toolbar.  
Now, click to turn it off. #

[6] Click Stop.

[3] Click OK.
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1.2-5  Create Section View

[1] In the Simulation 
Toolbar, select Plot 

Tools>Section Clipping.  
We'll create a section view.

[2] By default, Front 
plane is used as the first 

clipping plane.

[3] Click 
Section 2.

[4] Click to activate this 
box and select the Top 

plane from the Part Tree.  

[5] Click 
Reverse 
clipping 

direction.

[6] Click 
Section 3.

[7] Click to activate this box and 
select the Right plane from the 

Part Tree.

[9] Click 
Reverse 
clipping 

direction.

[8] Type 10 (mm) 
for Distance.

[10] Turn off 
Show section 

plane.

[11] Click OK.

[12] We'll explore the 
stress components at this 

location; let's call it 
location A.  This is a 

location where  σ X
 is large.

[13] And this location; let's call it 
location B.  This is a location 

where  τ XY
 is large. #



6.72 MPa

6.
72

 M
Pa

 Y

 Z
 X

51.6 MPa

51.6 MPa

6.72 MPa

6.
72

 M
Pa
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1.2-6  Stress Components at the Locations A and B

[1] Right-click Stress1 
and select Probe.

[2] Click location A to display the 
stress  σ X

.  You may enlarge the 
model to locate the corner more 

accurately.

[3] Click location B to 
display the stress  σ X

.

Stress 
Component Location A Location B

108.27 Mpa 51.588 Mpa

0 0

0 0

0 -6.724 MPa

0 0

0 0

 σ X

 σY

 τ XY

 τ XZ

 τYZ

 σ Z

[4] Use Probe to explore other 
stress components and tabulate 

the data like this.  Your stress 
values may not be exactly the same 
as here.  Note that the shear stress 

 τ XY
 at location B is negative.

 Y

 Z
 X

 108 MPa

 108 MPa

[5] The stress state 
at location A.

[6] The stress state at 
location B.  Note 

that the shear 
stresses point to 

negative directions. #
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1.2-7  Distribution of  σ X
 Along Horizontal and Vertical Edges

[1] In the Simulation 
Toolbar, select Plot 

Tools>Section Clipping.

[2] Click to turn 
off Section 2.

[3] Click OK.

[4] Make sure Stress1 
is associated with  σ X

.  
Right-click Stress1 
and select Probe.

[5] Click several locations 
along the upper edge of the 

section.  Keep the locations as 
equal-spaced as possible.
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[6] Click Plot.

[7] The  σ X
 is 108 MPa at 

the left and decreases to 
50 MPa at the right.

[8] Click to close 
the plot.

[9] Right-click here 
and select Clear 

Selections.

[10] Click several 
locations along the lower 
edge of the section.  Keep 

the locations as equal-
spaced as possible.
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[11] Click Plot.

[13] Click to 
close the plot.

[14] Right-click here 
and select Clear 

Selections.

[15] Click several locations along 
the vertical edge of the section.  

Keep the locations as equal-spaced 
as possible.

[12] The  σ X
 is -11.8 MPa at 

the left and increases to 50 
MPa at the right.
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1.2-8  Distribution of  τ XY
 Along a Vertical Edge

[1] Double-click 
Stress1 to edit the 
definition.  Change 

the Component to 
TXY ( τ XY

). [2] Right-click Stress1 
and select Probe.

[16] Click Plot.

[19] Click OK. #

[17] The  σ X
 distribution 

along the vertical edge is 
essentially linear.

[18] Click to close 
the plot.
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[3] Click several locations along the 
vertical edge of the section.  Keep the 
locations as equal-spaced as possible.

[4] Click Plot.

[7] Click OK.

[5] The  τ XY  distributes along the 
vertical edge parabolically.  We'll discuss 

more on this curve in Section 8.1.  A 
more accurate distribution is shown in 

8.1-5[11], page 160.

[6] Click to close 
the plot.

[8] Save the document and 
exit SOLIDWORKS. #
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Section 1.3

 P

 P

[2] The C-bar 
is used to 
measure a 
force P.

[3] A strain 
gauge is 

attached here.  
The measured 
strain is used 
to calculate 
the force P.

 4
0

 4
0

 D10

 12
0

 3
0

 20

  R10

  R50

 Z

 Y
Unit: mm.

 X

 70  20

 100

 Y

[1] The C-shaped bar is made of an alloy steel and used as a dynamometer, a 
device to measure the magnitude of a force P [2].  A strain gauge is usually 
attached to the surface of a location as shown [3], and the measured strain is 
used to calculate the force P.
� In this exercise, we will create a 3D solid model for the C-bar [4-6] and 
perform a static structural analysis under a force P = 2000 N.  We'll examine 
the stress states at two locations, A [7, 8] and B [9, 10].  We examine 
location A since it is where the strain gauge situated and its normal stress 

 σY
 is high.  Location B is arbitrarily chosen for its non-zero shear stress  τ XY

.
� This section also demonstrates a way to obtain results at specific 
location, namely using Sensors.

1.3-1  Introduction

[5] The body has a 
thickness of 5 mm 

everywhere.

[6] All unspecified fillets 
have radii of 3 mm.

[7] Location A.

[8] Location A.

[9] Location B.

[10] Location B. #

 110

 7
0

[4] Details of 
the C-bar.
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1.3-3  Create a Sketch for the Sweeping Path

[1] Launch SOLIDWORKS and create a new part.  Set up MMGS unit system with zero decimal places for 
the length unit. #

1.3-2  Start Up

[1] On the Front 
plane, draw a sketch 

like this.

[2] The origin.

[1] In Features Toolbar, 
select Reference 

Geometry>Plane.

1.3-4  Create a New Plane

[3] Click Exit 
Sketch. #



� Section 1.3  Stresses in a C-Bar� 38

[2] Click this line.

[3] The line is used as 
First Reference.

[4] Click this end 
point.

[5] The point is used as Second 
Reference.  A plane normal to 

the First Reference and 
passing through the Second 

Reference is created.

[6] Click OK. #

[1] While the new plane 
(Plane1) is highlighted in the 
Part Tree, click Sketch.

[2] In the Standard Views 
Toolbar, Click Normal To.

1.3-5  Create a Sketch for the Profile

[3] Draw a sketch 
like this.

[4] This is the line 
of symmetry. #
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1.3-6  Create a Solid Body Using Sweep

[1] Click Exit 
Sketch.

[2] In Features Toolbar, 
click Swept Boss/Base.

[3] The profile sketch 
(Sketch2) is pre-selected.  

If not, select it from the 
Part Tree.

[4] Select the path 
sketch (Sketch1) from 

the Part Tree.

[5] Click OK.

[7] A solid body is 
created. #

[6] In the Standard Views 
Toolbar, Click Trimetric.  Also, 
in the Head-Up Toolbar, turn-

off View Planes.
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1.3-7  Create an Ear

[1] In Part Tree, right-click 
Sweep1 and select Hide.

[2] In the Front plane, 
draw a sketch like this.  
Click Exit Sketch.

[3] Right-click Sweep1 and 
select Show.

[5] Select 
Mid Plane.

[6] Type 5 (mm).

[8] Click OK. #

[7] Make sure 
Merge result is 

enabled.

[4] In the Part Tree, click 
to highlight the newly created 

sketch (Sketch3) and, In 
Features Toolbar, click 
Extruded Boss/Base.

40� Chapter 1  Stresses



� Section 1.3  Stresses in a C-Bar� 41

1.3-8  Create Fillets

[1] In Features 
Toolbar, click Fillet.

[2] Create fillets 
of 3 mm on 
both sides. #

1.3-9  Mirror the Body

[2] From Part Tree, 
select Top plane.

[3] Click Bodies to 
Mirror.

[4] In the Graphics 
Area, select the body.

[1] In Features 
Toolbar, click Mirror.

[5] Click OK. #
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1.3-10  Create Sensor at Location A

[1] In Features Toolbar, 
select Reference 

Geometry>Point.

[2] Click this face.  A 
Reference Point is 

created at the center of 
the face.  This is the 

location A, where we 
want to set up a 

Sensor.
[3] Click OK.

[5] Right-click Sensors and 
select Add Sensor...

[6] Select 
Simulation 

Data.

[8] Set up Properties 
like this and select Point1 

from Part Tree.

[4] A Reference Point is 
created.

[9] Click OK. #

[7] Select SY.  The 
Sensor is initially 

set up to be 
associated with  σY

.  
It can be changed 

later.
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1.3-11  Create Sensor at Location B

[1] On the Front plane, draw a 
Sketching Point (see [2]) like 
this.  Specify the location of the 

point.  Click Exit Sketch.

[3] In Features Toolbar, 
select Reference 

Geometry>Point.

[5] In the Graphics Area, select 
the newly created Sketching 

Point.  A Reference Point is 
created at the location of the 

Sketching Point.

[6] Click OK.

[2] Sketching Point.

[4] Click On 
Point.
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[14] Save the 
document with the 

name CBar. #

[8] Right-click Sensors 
and select Add Sensor... [9] Select 

Simulation 
Data.

[11] Set up Properties 
like this and select Point2 

from Part Tree.

[12] Click OK.

[10] Select SY.  
The Sensor is 

initially set up to be 
associated with  σY

.  
It can be changed 

later.

[7] A second Reference 
Point is created.

[13] The sensor 
Stress1 will report the 
stress at location A, and 
the sensor Stress2 at 

location B.
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1.3-12  Create a Static Structural Study and Set Up Unit System

[2] A tab is added 
and becomes active.

[3] The Study Tree.

[1] Make sure SOLIDWORKS 
Simulation is loaded (1.1-5, page 13).  
In the Simulation Toolbar, select 

Study Advisor>New Study.  Type 
Static Force 2000 N for Name.  

Leave Static as default Study Type.  
Click OK.

[4] From Pull-Down 
Menus, select 

Simulation>Options...  
Make sure all settings are 
the same as those in 1.1-7, 

pages 15-16.

[5] In the Study Tree, right-click CBar and 
select Apply/Edit Material... and apply 

Alloy Steel for the model (1.1-8, page 17). #
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[1, 4] Right-click 
Mesh and select 
Create mesh...

[2] Click OK to 
accept the default 

settings.

[3] This is the default mesh.  In general, the 
finer the mesh, the more accurate the solutions.  

Let's make the mesh finer.

[6] Click OK.

[5] Drag the slider all the way 
to the right.  This is an easy 

way to refine the mesh.

[8] Right-click Mesh 
and select Details...

[7] We will use 
this mesh for 

this study.

1.3-13  Create Mesh

[9] The Mesh Details 
shows that the mesh consists 
of 102,660 nodes and 62,597 
elements.  Your numbers may 
not be exactly the same as 
here.  If you don't create a 

mesh, the program will 
automatically create a default 
mesh right before solving the 

model.

[10] Click to close the 
Mesh Details. #
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1.3-14  Set Up Boundary Conditions and Run the Model

[2] Click this 
cylindrical face.

[5] Click this 
cylindrical face.

[4] Right-click External 
Loads and select Force...[1] Right-click Fixtures and 

select Fixed Geometry...

[7] Select Top plane 
from the Part Tree.  It 

is used as a reference 
coordinate system.

[8] Click Normal to Plane; 
i.e., the direction of the force is 

normal to the Top plane.

[12] In the Simulation 
Toolbar, click Run This 

Study.

[3] Click OK.

[6] Click Selected 
direction.

[10] Type 2000 (N).

[9] Click Reverse 
direction.

[11] Click OK.
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[14] Hide all Fixtures 
and External Loads 
(1.1-12[6, 7], page 21).

[13] Change to display 
SY ( σY

) (1.1-12[1, 2, 4], 
page 21).

[17] Next, we'll explore 
the stresses at 

locations A and B. #

[15] Right-click 
Stress1 and select 

Animate...

[16] Click OK after 
viewing the 
animation.
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1.3-15  The Stresses at Location A

[1] Recall that the sensor Stress1 
is initially set up to be associated 
with  σY

 at A (1.3-10[7], page 42).  
Write down this stress value 

(59.2465 MPa) [5].

Stress 
Component Stress Value

0

59.2465 MPa

0

0

0

0

 σ X

 σY

 τ XY

 τYZ

 τ ZX

 σ Z

[2] Right-click Stress1 
and select Edit Sensor.

[3] Change to SX ( σ X
).

[6] Click OK.

[4] The sensor Stress1 
reports  σ X

 value here.  
The  σ X

 is essentially zero.

[5] Repeat steps [3, 4] to 
obtain other stress 

components.  All other 
stress components than  σY

 
are essentially zeros.

[7] The stress state 
at location A. #
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1.3-16  The Stresses at Location B

[1] The sensor Stress2 is 
initially set up to be 

associated with  σY
 at B 

(1.3-11[10], page 44).  Write 
down this stress value 

(21.7056 MPa) [5].

[2] Right-click Stress2 
and select Edit Sensor.

[3] Change to SX ( σ X
).

[6] Click OK.

[4] The sensor Stress2 
reports 

 σ X
 value here 

(9.94663 MPa).

[5] Repeat steps [3, 4] to obtain 
other stress components.  Your 
results may not be exactly the 

same as here.  Note that the Z-
components ( σ Z

,  τYZ
,  τ ZX

) are all 
zeros; it is called a plane stress 
state (Section 12.1).  The stress 
states discussed in this chapter 

are all plane stress states.

Stress 
Component Stress Value

9.94663 Mpa

21.7056 MPa

0

-20.5321 MPa

0

0

 σ X

 σY

 τ XY

 τYZ

 τ ZX

 σ Z

 Y

 X

9.95 MPa9.95 MPa

21.7 MPa

21.7 MPa

20.5 MPa

20.5 MPa

20
.5

 M
Pa

20
.5

 M
Pa

[7] The stress state at 
location B.  Note that the 
shear stresses point to the 

negative directions.

[8] Save the document and 
exit SOLIDWORKS. #
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